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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
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Postfach 48 48
90026 NÜRNBERG
GERMANY
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions form one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. These systems, machines and components should only be connected 
to the enterprise network or the Internet if and only to the extent necessary and with appropriate 
security measures (firewalls and/or network segmentation) in place.
You can find more information on protective measures in the area of industrial security by 
visiting:
https://www.siemens.com/industrialsecurity.
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends performing product updates as soon as they are available and 
using only the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under
https://www.siemens.com/industrialsecurity.
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Overview 2
Note
Read these notes carefully. They contain important information and additional details about 
SIMATIC PCS 7.
The information given in this Readme file takes precedence over all the SIMATIC PCS 7 
manuals.

You have received version V9.1 of the SIMATIC PCS 7 software. 
SIMATIC PCS 7 is the future-oriented process control system used in the "Totally Integrated 
Automation" concept by Siemens.
• Based on robust, industrial standard SIMATIC hardware and software components
• Modern, distributed system architecture
• Simple and quick system expansion and optimization in runtime
• Scalable from a small laboratory system to networks of plants
• For all applications: continuous and batch applications
• For all industries: process, production and hybrid sectors
• Efficient, plant-wide engineering
• Flexible and simple integration of field devices and drives based on PROFINET, PROFIBUS or 

Foundation Fieldbus 
• Homogeneously integrated safety technology, certified by the TÜV (German Technical 

Inspectorate)
• Support for open source interfaces based on international standards such as OPC
• Increased availability through redundancy at all levels
• Modular structured and scalable batch system, SIMATIC BATCH
• Flexible route control system, SIMATIC Route Control
• Conformity with EU GMP Guideline Annex 11 and 21 CFR Part 11
We hope that you enjoy using SIMATIC PCS 7 and have great success with it.
Your PCS 7 team
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Notes on installation 3
3.1 General information

Information on SIMATIC PCS 7 on the internet
All product and order information regarding SIMATIC PCS 7:
• Internet link (https://www.siemens.com/PCS7)
Overview of the most important technical information and solutions for SIMATIC PCS 7 in the 
Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/63481413)
Here, you can also subscribe to the newsletter, which keeps you constantly up-to-date with 
current information about our products. 
• Internet link (https://support.industry.siemens.com/My/ww/en/notifications)

Content of the SIMATIC PCS 7 Readme file
The SIMATIC PCS 7 Readme for SIMATIC PCS 7 V9.1 is available in two versions:
1. SIMATIC PCS 7 Readme (Offline)

This is the version that is installed during the PCS 7 setup. 
This file only contains general notes and links to documents on the internet.

2. SIMATIC PCS 7 Readme (Online)
This is the version which contains all information on the installation and use of SIMATIC PCS 7 
in the format you are already familiar with. 
This file is now only available on the internet so that we can keep it up to date. 
You can find the current version of this document for download under the entry ID 
109780270 in the Industry Online Support:
– Internet link (https://support.industry.siemens.com/cs/ww/en/view/109780270)

Note
Before you install or use SIMATIC PCS 7 V9.1, it is vital that you read the information from the 
most recent version of this document.

Each of the products comes with product-specific information in the form of readme files. 
The information contained in these readme files also applies to using products in SIMATIC PCS 7. 

Electronic manuals and help system on SIMATIC PCS 7
The following documentation can be accessed at any time on the SIMATIC PCS 7 USB flash drive 
in the folder "_Manuals\English" or "_Product_Information\English". 

PCS 7 Readme V9.1 (Online)
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PCS 7 - Documentation V9.1 
PCS 7 - Operating Instructions - OS Process Control V9.1
PCS 7 - Installation Manual - PC Configuration V9.1
PCS 7 - Configuration Manual - Engineering System V9.1
PCS 7 - Configuration Manual - Operator Station V9.1

Complete documentation for SIMATIC PCS 7 on the internet and document updates
The complete SIMATIC PCS 7 documentation is available in multiple languages at the following 
website:
• Internet link (https://www.siemens.com/pcs7-documentation)
You also have the option for updating the installed SIMATIC PCS 7 help system and post-installing 
the SIMATIC PCS 7 system documentation. For additional information, please refer to entry ID 
109744320 in the Industry Online Support:
• Download link (https://support.industry.siemens.com/cs/ww/en/view/109744320)

Note
Timeliness of online documents
Documents available online can be more up-to-date than the version of documents installed 
with SIMATIC PCS 7 setup. The statements in documents available online should therefore be 
given priority over installed documents. 

Notes on installation
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3.2 Type of delivery

3.2.1 Delivery package
The products listed below are delivered with the installation media required for the respective 
product: 
• SIMATIC PCS 7 V9.1 Software Media Package: 

– SIMATIC PCS 7 V9.1 on USB flash drive or as software download
– Certificate of License 　

• SIMATIC PCS 7 V9.1 Software Media Package ASIA: 
– SIMATIC PCS 7 V9.1 on USB flash drive 
– Certificate of License

The license keys required to operate the software for the supplied product are located on the 
License Key USB flash drive.
To simplify your license management, you can also save the license keys for other SIMATIC PCS 7 
products on this USB flash drive. Authorizations for older SIMATIC products must be saved on 
authorization disks.

3.2.2 Licensed commissioning of SIMATIC PCS 7 V9.1 ASIA
You will receive the SIMATIC PCS 7 V9.1 ASIA License Keys on a License Key USB Hardlock as 
license storage medium.
Use the Automation License Manager to transfer the licenses to the SIMATIC PCS 7 V9.1 ASIA PC 
during installation or afterwards.
Note the following when handling the license storage medium:
• Do not delete any files from the License Key USB Hardlock.
• Do not copy any data to the License Key USB Hardlock.
• Do not format the License Key USB Hardlock.
• Do not remove the License Key USB Hardlock from the computer while PCS 7 is running.

NOTICE
Demo mode
SIMATIC PCS 7 OS will change to demo mode when you remove the License Key USB Hardlock 
from the computer.

Notes on installation
3.2 Type of delivery
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3.2.3 SIMATIC PCS 7 Trial Mode
The software functions and configuration limits which are activated as part of the 14-day 
trial mode are not authorized for productive use.
SIMATIC PCS 7 trial mode is characterized by the following features:
• PCS 7 trial mode can be activated via the PCS 7 system setup or after the first start, and used 

for up to 14 calendar days in non-productive operation. 
After 14 days, it can no longer be used.

• The maximum capacity in Engineering and Runtime is 250 process objects. Please note that 
the "System blocks" in the PCS 7 trial mode are added to the limit count (for example, OB 
BEGIN, etc.). These "System blocks" are not displayed in the CFC process object statistics. 

• OS Runtime operation including SFC visualization is possible on a single station (no client 
server, no web server, no redundancy).

• SIMATIC BATCH can be used with up to 10 units. 
• The BATCH API cannot be used in trial mode.
• SIMATIC Route Control can be used for up to 30 routes.
• All other PCS 7 functions/configurations/capabilities (for example Import/Export Wizard, 

Client server, more than 250 PO) are not available in the PCS 7 trial mode.
• After installing the licenses for productive operation (see the catalog ST PCS 7), the PCS 7 trial 

mode can also be installed for indefinite productive operation with a scope of functions 
corresponding to the license that was purchased and installed.

3.2.4 Notes on the license contract for the SQL server
Note that SIMATIC PCS 7 also includes the SQL Server software licensed by Microsoft 
Corporation. With the use of SIMATIC PCS 7, you agree to be bound by and to abide by the 
attached Microsoft terms and conditions for end customers for the Microsoft SQL Server.
The Microsoft "SQL Server" supplied with PCS 7 must not be used outside the PCS 7 environment 
without prior written consent from Siemens.

Notes on installation
3.2 Type of delivery
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3.3 Hardware requirements

3.3.1 PC hardware

3.3.1.1 Recommended PC hardware configuration

Recommended basic hardware configuration
We recommend the following configuration for PC components (the higher the quality of the 
equipment, the better):

Parameters Central engineering station with server op‐
erating system, Process Historian, Informa‐
tion Server, 
PCS 7 OS / SIMATIC BATCH / SIMATIC Route 
Control on a PC, 
Engineering station, 
OS server, 
OS single station, 
Maintenance Station, 
SIMATIC PAM Station,
PCS 7 Web server, OS client and BATCH cli‐
ent on a PC, 
BATCH server, 
BATCH single station, 
Route Control server, 
Route Control single station
SIMATIC Management Console

OS client, 
BATCH client, 
Route Control client

Basic PC (see catalog) SIMATIC IPC 547G / 647D / 847D / 647E / 847E  SIMATIC IPC 547G / 647D / 847D / 647E / 
847E / 627D / 677D / 627E / 677E

Processor >= Core i5-4570TE (2C/4T, 2.7 GHz, 4MB 
Cache, TB, VT-d, AMT)

>= Core i3-4330TE (2C/4T, 2.4 GHz, 4MB 
Cache)

Work memory (RAM) >=16 GB (64-bit operating system) >=4 GB (64-bit operating system)
Hard disk
Partition size

>=200 GB HDD/SSD
C:\ 100 - 128 GB

>=160 GB HDD/SSD
C:\ 100 - 128 GB

Network adapter /
Communications interfaces 
• For terminal bus communica‐

tion
• For plant bus communication

 
 
• RJ45 on-board gigabit Ethernet
• CP 1623 or BCE network adapter

 
 
• RJ45 on-board gigabit Ethernet

Notes on installation
3.3 Hardware requirements
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Parameters OS client
Basic PC (see catalog) SIMATIC IPC427E / IPC477E
Processor Core i5-6442EQ (4C/4T, 1,9(2,7)GHz, 6MB Cache)
Work memory (RAM) >= 4.0 GB
Hard disk
Partition size

>=160 GB HDD/SSD
C:\ 100 GB - 128 GB

Network adapter/communications interfaces 2 x RJ45 on-board Gigabit Ethernet
without PROFINET or PROFIBUS interface

Purpose Approved for OS/Batch client operation only

Parameters SIMATIC PDM MS
Basic PC (see catalog) SIMATIC IPC427E
Processor Core i5-6442EQ (4C/4T, 1,9(2,7)GHz, 6MB Cache)
Work memory (RAM) = 16.0 GB
Hard disk
Partition size

>=160 GB HDD/SSD
C:\ 100 GB - 128 GB

Network adapter/communications interfaces 3 x RJ45 on-board Gigabit Ethernet
Purpose Approved for PDM MS operation only

We recommend the following configuration for Box / Microbox  components (the higher the 
quality of the equipment, the better):

Parameters SIMATIC IPC 627D / 677D / 627E / 677E SIMATIC IPC427D
Processor >= Core i3-4330TE (2C/4T, 2,4GHz, 4MB 

Cache, VT-x)
Core i7-3517UE (2C/4T, 1.7(2.8)GHz, 4MB 

Cache)
Work memory (RAM)  >= 16 GB (64-bit operating system) 4.0 GB
Hard disk
Partition size

>=200 GB HDD / SSD
C:\ 100 - 128 GB

SSD: 80 GB

Network adapter/communica‐
tions interfaces

• 2 x RJ45 on-board Gigabit Ethernet
• CP 1623 or BCE network adapter (BCE also 

via onBoard Gigabit Ethernet)

• 2 x RJ45 on-board Gigabit Ethernet
• onBoard PROFIBUS CP 5622
• onBoard PROFINET CP 1616

Purpose SIMATIC IPC627 / IPC677 is released as part of 
the PCS 7 BOX compact systems.

PCS 7 AS RTX based on SIMATIC IPC427D 
only released for AS operation.

Notes on installation
3.3 Hardware requirements
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Note
• In the case of multi-user engineering, it is beneficial for the engineering stations if you use 

PCs with high clock-pulse rates, large main memories and hard disks, and high-speed disk 
drives. In addition to the Microsoft recommendation of "15% free space", we recommend 
that you reserve at least 2 GB of free space (depending on the size of the project) on the 
system partition.

• Integrity check fails if a new file/folder is added to the PCS 7 Bundle.
• When using Process Historian, also read the notes in the "Hardware requirements" section in 

the Process Historian 2020 installation manual.
• In the case of multi-VGA configurations with extensive graphical engineering, a CPU clock 

frequency that is as high as possible is recommended. In these cases deactivating Hyper-
Threading in the BIOS of the OS Client can result in increased performance of the graphics 
output.

• When using Microsoft Windows Server 2019 Standard with Hyper-V Virtualization on 
IPC647E / IPC847E, read the notes in the "Hardware requirements" chapter of the PCS 7 
Virtualization - Project Engineering and Configuration manual.

Additional information 
The catalogs of the PCS 7 system components (ST PCS 7 for SIMATIC PCS 7 V9.1) as well as the 
add-on catalog (ST PCS 7 for V9.1) is provided in the Information und Download Center:
• Internet link (https://new.siemens.com/global/en/products/automation/topic-areas/process-

automation/catalogs-for-process-automation.html)

3.3.1.2 Compatibility matrix SIMATIC IPC and accessories for PCS 7 V9.1

Compatibility matrix SIMATIC IPC and accessories for PCS 7 V9.1
PCS 7 V9.1 Article no. Windows 7 Ul‐

timate 32-Bit 
SP1

Windows 
10 

Enterprise 
LTSC 2019

64-Bit

Windows 
Server 
2019 

Standard 
Edition, Da‐

tacenter 
Edition

(SIVaaS on‐
ly) 64-Bit

RACK IPC     
IPC547G 6ES7 660-7....-.... - X X
IPC647D 6ES7 660-5....-.... - X X
IPC647E 6ES7 661-0....-.... - X X
IPC847D 6ES7 660-6....-.... - X X
IPC847E 6ES7 661-1....-.... - X X

Notes on installation
3.3 Hardware requirements
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PCS 7 V9.1 Article no. Windows 7 Ul‐
timate 32-Bit 
SP1

Windows 
10 

Enterprise 
LTSC 2019

64-Bit

Windows 
Server 
2019 

Standard 
Edition, Da‐

tacenter 
Edition

(SIVaaS on‐
ly) 64-Bit

     
BOX IPC     
IPC627D, IPC677D2) 6ES7 650-4B...-.... - X -
IPC627E, IPC677E2) 6ES7 650-4C...-.... - X X
     
Microbox     
IPC427D, PCS 7 AS RTX 
(RTX 2010)

6ES7 654-0UE23-0XX1 X - -

IPC427D, PCS 7 AS RTX 
(RTX 2010)

6ES7 654-0UE23-0XX2 X - -

IPC427E, IPC477E OS cli‐
ents

6ES7 650-0VG..-.... - X -

IPC427E, PDM MS V4.0 6ES7 650-0RJ04-0YX0 - X -
     
CPs     
CP 1623 6GK1 162-3AA00 - X X
CP 1628 6GK1 162-8AA00 - X X
     
Accessories     
Intel Gigabit CT desktop 
adapter (EXPI9301CT)

A5E02639550 - X X

NVIDIA NVS315 A5E36966175 - X X
NVIDIA QUADRO P400 A5E44936965 - X X
SIMATIC PCS 7 USB smart 
card reader (OK3121)

6ES7 652-0XX02-1XC0 - X1) X1)

TCOS 3.0 smart cards 6ES7652-0XX00-1XD2 - X X
Signal module, PCI card for 
installation in an operator 
station

6DS1 916-8RR - X X

Legend for the table: 
"-" = incompatible
"X" = compatible
Footnotes:
1) With SIMATIC Logon.
2) WinAC RTX Operation with PCS 7 V9.1 on PCS 7 BOX compact system is no longer supported.
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3.3.1.3 Network

Network configuration
The network for the PCS 7 systems must be isolated via switches, routers or gateways in such a 
way that no external interference can affect the PCS 7 network.
You can find recommendations for this in the document:
• PCS 7 Security Concept PCS 7 & WinCC (Basic)
The document is available for download under the entry ID 109780811 in the Industry Online 
Support:
• Download link (https://support.industry.siemens.com/cs/ww/en/view/109780811)

3.3.2 AS hardware

Documentation on hardware
The versions of the AS hardware components that are approved for PCS 7 V9.1 are described in 
the manual "PCS 7 - Released Modules". You can find this document on the website for 
SIMATIC PCS 7 Technical Documentation (https://siemens.com/pcs7-documentation).

Time synchronization
We generally recommend the use of a central system clock.
You can find notes on central time clock in the "PCS 7 – Time synchronization" function manual. 
You can find this document on the website for SIMATIC PCS 7 Technical Documentation. 
• Internet link (https://siemens.com/pcs7-documentation)
You can find additional information on SICLOCK products under entry ID 67638218 in the 
Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/67638218)
We have tested the compatibility of products from the BÜRK MOBATIME GmbH company with 
regard to time synchronization.
You can find notes on time synchronization with BÜRK MOBATIME GmbH products under entry 
ID 109760344 in the Industry Online Support: 
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109760344)
When using the internal Ethernet/PROFINET interface, the CPUs 6ES7414-3EM05-0AB0, 
6ES7414-3EM06-0AB0, 6ES7414-3EM07-0AB0, 6ES7416-3ER05-0AB0, 6ES7416-3ES06-0AB0 
and 6ES7416-3ES07-0AB0 can only be synchronized with the NTP method. For the previous CPU 
types, we continue to recommend that you use the SIMATIC method.
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3.4 Installation of the software, software requirements

3.4.1 Software installation

3.4.1.1 Requirements

Released operating systems
The following operating systems are supported in PCS 7 V9.1:
• Windows 10 Enterprise LTSC 2019
• Windows Server 2019 Standard Edition
• Windows Server 2019 Datacenter Edition

Note
The Windows Server 2019 Datacenter Edition is only supported in conjunction with the service 
contract SIMATIC Virtualization as a Service (SIVaaS). For additional information, please refer to 
entry ID 109762004 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109762004)

Note
Installation to PCS 7 V9.1
Before you start with the installation of PCS 7 V9.1 on your computers, ensure that the currently 
released MS patches for the respective operating system are installed on the computers.
For information about the handling of current Microsoft security patches in PCS 7 please refer 
to the topic "Patch management and security updates" in this section.

Released processor architectures
Only the x64 platform is used for processor architectures which support 64-bit memory 
addressing.
Systems with Intel Itanium CPU architecture (IA64) are not supported.

Compatibility list of the PCS 7 PC configurations and operating systems
Not all configurations are suitable for every operating system. The following table shows the 
relationship of the most common configurations of PCS 7 to the operating systems.
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Before performing the installation, refer to the product-specific readme files to ensure that the 
product being installed is suitable for the desired operating system.

SIMATIC PCS 7 V9.1
SW components

Windows 10 Enter‐
prise LTSC 2019 

Windows Server 
2019 Standard Ed‐
ition

Windows Server 
2019  Datacenter 
Edition (SIVaaS on‐
ly)

ES X X X
OS-Single Station X X X
ES/OS-Single Station X X X
OS-Server  X X
OS-Client X X X
Web-Server X X X
Web-Client X X X
Process Historian1)  X X
Information Server X X X
SIMATIC Management Console X X X
SIMATIC PAM Station  X X
SIMATIC PDM MS X   
SIMATIC Batch Single Station X X X
SIMATIC Batch Client X X X
SIMATIC Batch Server  X X
SIMATIC Route Control Server  X X
SIMATIC Route Control Client X X X
OpenPCS 7 X X X
PCS 7 BOX X X  
OS-Client Microbox X   
Microsoft Windows Domain Controller  X X

1) With PCS 7 V9.1 the PH software is only usable as single PH

Note
Released operating systems
The specifications of released operating systems made in this Readme take precedence over any 
other contradictory specifications made in the Readme files of the individual products.

Microsoft Internet Explorer
Only Internet Explorer 11 is permitted.
• Internet link (https://windows.microsoft.com/en-US/internet-explorer/ie-11-worldwide-

languages)
Internet Explorer 11 attempts to automatically install the required Microsoft Patches (KB) during 
the installation. If this installation fails, the installation procedure is aborted. In this case, you 
need to install the required KBs manually before you can install Internet Explorer 11.
• Internet link (https://support.microsoft.com/kb/2872074)
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Note
Google Chrome or Mozilla Firefox is required to access the Information Server.  

Microsoft .NET Framework
The Microsoft .NET Framework feature must be enabled prior to the installation of the 
SIMATIC PCS 7 software.

Windows Server 2019
Read the information from Microsoft:
• Internet link (https://msdn.microsoft.com/en-us/library/hh506443(v=vs.110).aspx)
If you enable the ".NET Framework" feature without an internet connection, you can use the 
Windows installation medium as the file source:
1. Insert the Windows installation medium. 
2. Run the following command in the command prompt with higher-level rights: 

Dism.exe /online /enable-feature /featurename:NetFx3 /All /Source:<DVD drive 
letter>:\sources\sxs /LimitAccess

PCS 7 system setup
Other required parts of the Microsoft .NET Framework are automatically installed with the 
SIMATIC PCS 7 system setup.

Microsoft SQL Server 
Microsoft SQL Server 2017 is installed automatically by the PCS 7 system setup. The computer 
name must be set before SQL Server is installed. The computer name cannot be changed 
afterwards.

Note
SQL Server Management Studio (SSMS) will not be delivered with PCS 7 V9.1. The user can 
download the software from here - Download SQL Server Management Studio (SSMS) (https://
docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?view=sql-
server-2017).

Notes on installing the operating system
Before installing PCS 7, you must install an operating system released for the planned PCS 7 
configuration.
The use of tools such as Windows Easy Transfer to transfer data and settings between different 
operating systems or to perform a direct upgrade from a previous operating system (e.g. from 
Windows 7 to Windows 10) has not been approved.
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The use of the following operating system features has not been approved for PCS 7:
• HomeGroup (only available with Windows 10)
• Parental Control (only available with Windows 10)
• BitLocker
• Fast User Switching (The use of this feature can be disabled by the administrator via a group 

policy. You can find additional information on the procedure on the SIMATIC PCS 7 USB flash 
drive in the folder _Manuals\English "PCS 7 - PC Configuration.pdf" in the section "How to 
disable user switching").

Windows Software Update Services (WSUS)
The WSUS cannot install software versions that are not described in this document as a 
minimum system requirements. This includes service packs for Microsoft operating systems, 
SQL Server, Office or new versions of Internet Explorer. 
This guideline does not apply to the mentioned patch classifications published under entry ID 
18490004:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/18490004)
You need to operate the WSUS at least on the basis of Windows Server 2019 for patch 
management of plant computers using the Windows 10 and Windows Server 2019 operating 
systems.
Also read the information from Microsoft for setting up the WSUS:
• Windows Server Update Services (WSUS) (https://docs.microsoft.com/en-us/windows/

deployment/update/waas-manage-updates-wsus)

Patch management and security updates
You can find information on the use of the latest Microsoft updates in the Industry Online 
Support under entry ID 18490004:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/18490004) 
To ensure secure and stable operation of the operating system and therefore PCS 7, we 
recommend the installation of the mentioned updates.

Note
Configuration for automatic updates with Windows 10 Enterprise LTSC 2019 and 
Windows Server 2019
The "Patch management" section of the configuration manual "PCS 7 Compendium Part F - 
Industrial Security" (https://support.industry.siemens.com/cs/ww/en/view/109782722) 
describes the recommended PCS 7 settings for automatic updates.
If these settings are enabled, the user is notified about available updates by the Windows 
operating system. 
The WinCC option "Disable shortcut keys for operating system access" prevents the operator 
from accessing the operating system level. Notification of available updates is prevented.
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Additional information on the topic of industrial security and plant security 
You can find additional documents and information on the topic of industrial security and plant 
security in the Industry Online Support, in the "All-round protection with Industrial Security - 
Plant Security" entry list and the document:
• Internet link  (https://support.industry.siemens.com/cs/ww/en/view/109782722)

Permitted domain controllers (DC)
• Domain controller (DC) based on Windows Server 2019
• Domain controller (DC) based on Windows Server 2016

Operating system languages
When you use PCS 7, you will have to set the required language and region at every point in the 
Windows language settings. This affects all the settings available under “Region and Language”.
If you use PCS 7 ASIA, make the following settings in the Windows regional and language 
options:
• Select "Chinese (PRC)" for "Language for non-Unicode programs". You need to make these 

settings before installing the PCS 7 software.
• For the "Display language", select "English (USA)" if you have set the language of the PCS 7 

user interfaces to English.
• For the "Display language", select "English (USA)" or "Chinese (Simplified)" if you have set the 

language of the PCS 7 user interfaces to Chinese.
• For the "Format", select "Chinese (PRC)". 
Then copy these settings for the following accounts:
• Welcome page and system accounts
• New user accounts

Rules for computer names
The selection of the computer name is critical for the entire project configuration:
• Illegal characters: . , ; : ! ? " ' ^ ´ ` ~ - + = / \ ¦ @ * # $ % & § ° ( ) [ ] { } < > space, hyphen ("-"), 

underscore ("_")
• Max. 15 characters
• Uppercase letters only
• The first character must be a letter.
It is always advisable that only alphanumeric characters are used for the computer name. You 
should choose a name consisting of uppercase Latin letters (A-Z) and digits (0-9) only, starting 
with a letter and containing a maximum of 15 characters.
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Before installing the PCS 7 software
• Message queuing must be enabled for PCS 7.

Security settings
You can find information about the security settings in the "_Manuals\English" folder, "PCS 7 - 
PCS 7 PC Configuration.pdf" document on the SIMATIC PCS 7 USB flash drive in the sections "PC 
configuration security settings" and "Firewall in PC stations".
Settings need to be made in the registry, the DCOM configuration and the exception list of the 
Windows firewall for the PCS 7 software to operate correctly. 
These settings are made during the installation of PCS 7 (system setup) by the "Security 
Controller" application. 
The "Setup - System Settings" dialog box appears before the installation begins. There, the 
system settings to be changed are listed. 
To continue the setup, you need to agree to the change to these system settings.

Note
Please note the following:
• The settings must be applied again if the work environment changes (domain, workgroups). 

You can open the Security Controller with the menu command:
– Windows 10 Enterprise LTSC 2019: Start > All Apps > Siemens Automation > Security 

Controller > Repeat Settings.
– Windows Server 2019: Start > Siemens Automation > Security Controller > Repeat 

Settings. 
• Start the Security Controller after the PC has been added to the domain and rebooted. 

Remember that the Windows services that are required for the Security Controller are not 
immediately available after Windows logon. If the tool is started without entries, restart it 
after a brief interval.

• The settings in the exception list of the Windows firewall are applied to the area of the local 
network (subnet). If your PC stations are located in different networks (subnets), you need to 
change this area manually.

• If you need to make local Windows firewall settings that differ, they should be adapted 
afterwards.

OPC XML DA
OPC XML DA has not been released.

Setting the permissions for restarting the system
When using Windows Server operating systems, users without administrator rights must be 
provided authorization for "System Shutdown".
Without these rights, the system cannot be restarted.
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As an administrator, you can set the permission for other user groups using a group policy as 
follows:
1. Use the search box in the start menu to open the file "gpedit.msc".

The "Local Group Policy Editor" dialog box opens. 
2. In the tree view, select Local Computer Policy > Computer Configuration > Windows 

Settings > Security Settings > Local Policies > User Rights Assignment. 
3. Double-click the "Shutdown the system" object in the detailed window. 

The "Properties of shutdown the system" dialog box opens. 
4. Click the "Add Users or Group" button. 

The "Select Users or Groups" dialog box opens. 
5. Select all desired users or groups. 
6. Click the "OK" button to apply the settings.

Note
As of Windows Server 2019, the local Administrators group can no longer be used in this context. 

Notes on installing the software over a network
To be able to install on multiple computers at the same time, you need to make the contents of 
the SIMATIC PCS 7 USB flash drive is available in one storage location (shared network path). 
The following rules apply to the storage:
• The folders must be located within a shared folder.
• The name of the access path to the network copy of the USB flash drive cannot contain more 

than 85 characters.

Note
The PCS 7 installation source share access rights for the users who wants to install software from 
this repository needs to be restricted to read only.

Use of additional software for creating and viewing PDF documents
The PDF-XChange 8.0 software for creating and viewing PDF documents has been tested with 
PCS 7 V9.1 for compatibility and can be installed subsequently.
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3.4.1.2 Notes on installing the software

New installation 
There are two possible ways to install PCS 7:
1. Installation of a previously backed up image of the operating system. 

This image cannot contain a PCS 7 installation and a redundant PH. 
You can then install PCS 7 on this image.

2. New installation of the operating system followed by new installation of PCS 7.
You can find detailed information about the installation requirements and procedure in the 
"PCS 7 PC Configuration.pdf" document in the "_Manuals\English" folder on the SIMATIC PCS 7 
USB flash drive.

Steady state
During the installation of the PCS 7 software, the system must be in steady state:
Make sure that no updates are being performed for antivirus software or the Windows Software 
Update Services (WSUS) during the installation. You can ensure this by temporarily disabling the 
corresponding options in each program.

Installation on computers with multi-core processor
When you install the PCS 7 software on PC hardware with multi-core processors in which the 
number of processors does not equal 2n, or when you use NUMA (Non Uniform Memory Access), 
you must follow the instructions under entry ID 59703368:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/59703368)
PC hardware based on SIMATIC IPC recommended for PCS 7 is not affected by this.

Installation via network 
When performing a network installation of PCS 7, ensure that read only access to the setup 
procedure is guaranteed, even if the computer reboots during the PCS 7 setup. If the computer 
is not in a domain, you must enter the logon information of the user in order to access the 
network share for the server in the Windows Credential Manager.

Note
The PCS 7 installation source share access rights for the users who wants to install software from 
this repository needs to be restricted to read only.

Close the Internet Explorer (IE11) before starting the installation
Before starting the PCS 7 setup, make sure you have correctly closed IE11. Close any processes 
still running (iexplore.exe), for example, by using the Windows Task Manager.
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Installation of Information Server 2020 web application
The Information Server 2020 web application can be installed in two modes: 
• Website
• Virtual directory 
Subscriptions for automatic creation of IS Excel reports are only possible, if the Information 
Server is installed as a website.

Installation via SIMATIC Management Console
You cannot install the following products from the "Additional_Products" folder of the SIMATIC 
PCS 7 USB flash drive using the SIMATIC Management Console:
• DiagMonitor
• MTU
• SAS-DC
• Information server BATCH options
• Crystal Reports XI for Route Control
• SIMIT_VC_for_PDM_MS
When creating and using setup packages for the installation of SIMATIC software, it is mandatory 
to input English characters for some entries. If you wish to use setup packages, always input 
English characters for the following entries (Asian characters are not permitted):
• Name of the software or the software package
• Name of the required, shared storage location 
You can find a list of all products and PCS 7 components that can be installed via the 
SIMATIC Management Console under entry ID 107796665 in Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/107796665)

Installation of the SIMATIC Management Agent
The SIMATIC Management Agent is automatically installed with every installation of PCS 7 to 
facilitate the integration of your computers in a plant managed with the 
SIMATIC Management Console. 
However, if it was not explicitly selected for installation, the associated service of the same name 
is disabled.
The computer cannot be managed through the SIMATIC Management Console in this state.
To enable its active use, proceed as follows:
1. Open the Microsoft Management Console for services using Start > Run: enter "services.msc".
2. Change the "Startup type" to "Automatic" for "SIMATIC Management Agent".
3. Start the service by pressing the "Start" button.
4. Click "OK" to close the dialog box.
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Note of the documentation packages in PUD Manager Help Viewer
With the  installation of PCS 7 V9.1, the help system is delivered with inbuilt PUD files of the 
following manuals along with the documentation of various product components of PCS 7:
• PCS 7 - Documentation V9.1 
• PCS 7 - Operating Instructions - OS Process Control V9.1
• PCS 7 - Installation Manual - PC Configuration V9.1
• PCS 7 - Configuration Manual - Engineering System V9.1  
• PCS 7 - Configuration Manual - Operator Station V9.1
The user can update or customize his own Manual collection. For more details, please refer to 
Process Control System PCS 7; PUD Manager Online Help (https://support.industry.siemens.com/
cs/ww/en/view/109748882).

Notes on uninstalling PCS 7
Uninstalling PCS 7 software components via the system setup is not supported. 
The Uninstallation of single software components via the Windows control panel is not 
recommended.
 

3.4.1.3 Notes on update 

Updating PCS 7 projects
Users can upgrade their projects from PCS 7 V8.2 SP1 or PCS 7 V9.0 SP3 to PCS 7 V9.1. When 
updating the software, read the manuals "Software Updates Without Utilization of New 
Functions" or "Software Updates With Utilization of New Functions". You can find both 
documents on the website for SIMATIC PCS 7 Technical Documentation:
• Internet link (www.siemens.com/pcs7-documentation)

Updating the PCS 7 Software
General
Update installation is not supported as of PCS 7 V9.1.

Updating a Process Historian/Information Server system 
PCS 7 V9.1 contains the version "Process Historian/Information Server 2020". 

Note
• Process Historian/Information Server of older versions cannot be upgraded to the latest 

version as of PCS 7 V9.1. 
• PCS 7 V9.1 does not support the redundant Process Historian.
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You can find the "InstallNotesPRHIdeDE.pdf" file on the SIMATIC PCS 7 USB flash drive in the folder 
"27b_PH+IS_Install_and_Release-Notes".

3.4.2 Microsoft Windows settings

General information
You can find information about the settings on the SIMATIC PCS 7 USB flash drive in the folder 
"_Manuals\English" in the document "PCS 7 - PCS 7 PC Configuration.pdf".

Settings for the Microsoft Internet Information Service (IIS)
The Internet Information Service is a prerequisite for the installation and use of certain PC 
stations (Web server, Information Server).
You can learn about the settings required to configure the IIS in the documentation for the 
respective product used (e.g. the Web server installation instructions). You also need to read the 
information on configuration of the IIS in the document "PCS 7 - PCS 7 - PC Configuration.pdf". 

3.4.3 Installation of engineering station (ES) and operator station (OS) on a single 
PC

If you wish to install an "Engineering Station" on an existing OS, it is essential that it should 
completely be a new installation as uninstallation is not supported in PCS 7 V9.1.

3.4.4 Installation of SIMATIC NET products
SIMATIC NET products always must be installed by using the system setup for PCS 7.

Possible applications for the SCALANCE S, CP 443-1 Advanced and CP 1628 security products in the 
PCS 7 environment

You can learn how to use the SIMATIC security products SCALANCE S, CP 443-1 Advanced and 
CP 1628 with PCS 7 from entry ID 67329379 in Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/67329379)
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3.4.5 Use of the Media Redundancy Protocol (MRP) 

Network topologies
It is absolutely necessary to operate the PROFINET fieldbus ring with MRP (Media Redundancy 
Protocol) when using rings with PROFINET. The media redundancy protocols HRP (High Speed 
Redundancy Protocol) and MRP cannot be used simultaneously in the same ring. The PROFINET 
fieldbus ring can only consist of devices that support MRP functionality. 
The MRP (Media Redundancy Protocol) can be used as a standard for terminal bus, plant bus  and 
fieldbus. The advantage of using of MRP, is the continuous usage of MRP-I (Media Redundancy 
Protocol Interconnect) as redundant connection between MRP rings.

 HRP Standby MRP MRP-I
Separate terminal and plant 
bus

X X X X

Common terminal and plant 
bus

X X X X

PROFINET fieldbus - - X -

Note
The SCALANCE XC/XP/XF2xx switches with a firmware version V4.2 is coming with MRP-I.
The SCALANCE XR/XM switches with a firmware version V6.3 is coming with MRP-I.

Configuration of the watchdog time for PROFINET fieldbus
In the event of a transmission line failure, reconfiguration of the network (switching to the 
redundant transmission line) can take up to 200 ms.
Increase the watchdog time for each station by: 
• Selecting the "Fixed update time" setting
• Increasing the update time to a value that is smaller than the fastest update of the process 

image partition (PIP) for this station
• Increasing the number of accepted update cycles with missing I/O data, so that the watchdog 

time is > 200 ms
See also, entry ID 46636225
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/46636225) 
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3.4.6 Settings for standard network adapters (BCE and Softnet)

3.4.6.1 Plant bus with TCP/IP protocol
Make the following settings for the plant bus:
• Disable "File and Printer Sharing for Microsoft Networks"
• Disable "Client for Microsoft Networks"
• Activate the "SIMATIC Industrial Ethernet (ISO)" log
Refer to the information in the PCS 7 Engineering System Configuration Manual, PCS 7 Operator 
Station Configuration Manual and the WinCC Information System: "Special aspects of 
communication in a server with multiple network adapters".

3.4.6.2 BCE and time synchronization
When synchronizing the time via BCE, select the following settings: 
• 1 - 10 sec. intervals on the external time transmitter
• The ISO protocol be installed and enabled for the network adapter.
• Only one network adapter (BCE) can be used for time synchronization on an OS.
• Use the following multicast destination address for time synchronization with BCE: 

09-00-06-01-FF-EF
• Broadcast cannot be used
You can find additional information on the configuration of time synchronization in a PCS 7 plant 
in the "PCS 7 Time Synchronization" manual.

3.4.6.3 SIMATIC Shell
The SIMATIC Shell dialog appears after new installation of the PCS 7 software. However, if it does 
not appear, the user must manually open the dialog and make the required communication 
settings. For more information on how to set the communication settings, refer "How to set the 
communication module for connecting to the terminal bus" section in the PCS 7 PC 
configuration V9.1 manual.

3.4.7 Installation of older versions of PCS 7 libraries

Post-installation of the current version
Following the installation of PCS 7 V9.1, when you install or remove an Older version of the PCS 7 
Library, the PCS 7 Basis Library or PCS 7 Advanced Process Library, you must subsequently re-
install the current version of the PCS 7 Basis Library. This is necessary in order to guarantee 
proper functioning of the CFC driver generator.
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Downloading older versions
You can find the libraries of older PCS 7 versions available for download under entry ID 
109480136 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109480136)

Compatibility of older versions
You can check the compatibility of older libraries under entry ID 64847781 in the Industry 
Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

3.4.8 Using antivirus software and whitelisting protection mechanisms

Approved antivirus software
You can find additional documents and information on the topic of industrial security and plant 
security in the Industry Online Support, in the "All-round protection with Industrial Security - 
Plant Security" entry list and the "PCS 7 Compendium Part F - Industrial Security" manual:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/50203404)
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109782722)
The following virus scanners have been tested with PCS 7 V9.1 for compatibility and can be 
installed subsequently even with an existing PCS 7 installation:
• Windows Defender
You can find the product version of the corresponding virus scanner suitable for your PCS 7 
version in the regularly updated entry ID 64847781 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

Using Whitelisting protection mechanisms
Whitelisting mechanisms provide protection for the installation of PC systems by prohibiting the 
execution of unauthorized software or modification of installed applications. 
Additional security applications are installed to enable such protection. 
The following application Whitelisting software has been tested with PCS 7 V9.1 for 
compatibility:
• McAfee Application Control
You can find the product version of McAfee Application Control (V8.3.2) suitable for your PCS 7 
version in the regularly updated entry ID 64847781 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)
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You can find additional information on the "Utilization of Whitelisting with McAfee Application 
Control in a PCS 7 / WinCC Environment" in Industry Online Support under entry ID 88653385:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/88653385)

3.4.9 Digital certificates
Take note of entry ID 87057037 for checking digital certificates in your system. Checking of the 
certificates is necessary to ensure secure operation of the system and to avoid timeouts. It also 
helps in preventing error messages of the digital signature during installation of the Web Client 
and the required Web plug-ins.
•  Internet link (https://support.industry.siemens.com/cs/ww/en/view/87057037)

3.4.10 Shutting down Windows, standby mode / hibernation
Whenever you shut down Windows on your PCS 7 computers, use the command "Start > 
Shutdown Computer" and then select "Shutdown" or "Restart". 
The use of "Standby mode" and "Hibernation" has not been released as part of PCS 7.

3.4.11 SIMATIC Logon

SIMATIC Logon
The term "SIMATIC Logon Admin Tool" has been replaced by "SIMATIC Logon Role Management".

Note on the use of smart cards
All smart cards that were formatted with SIMATIC Logon < V1.3 must be formatted again with 
a version > V1.3. This is necessary because SIMATIC Logon uses improved encryption for smart 
cards as of V1.3. If you attempt to log on with a smart card that is not updated, the attempt will 
fail. However, you can always log on with your username and password via the keyboard.
Only smart cards with TCOS version 3.0 are supported as of PCS 7 V9.1.

Note
If you have logged on with a chip card and remove this chip card during configuration in the 
SIMATIC Logon role management, all the changes that you have not saved up to this point are 
discarded.
Reinserting the card will not solve this problem.
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Notes on the Windows workgroup 
If you require high availability of the user logon, you must operate PCS 7 in a domain 
environment, because SIMATIC Logon does not support redundant logon servers in a Windows 
workgroup.

Notes on the SIMATIC Logon Event Log Viewer
If you want to print the events in the event log, proceed as follows:
• Click "Export" and export the events in PDF format.
• Print out the exported file.
Instead of the file size of the event log, the number of recorded events corresponding to the 
configured filter is displayed.
The filter dialog box always shows the date and time based on the settings you have selected for 
the date and time in Windows. Display in conformity to ISO 8601 is not possible.

3.4.12 Using Microsoft Office
The following Microsoft Office products have been tested for compatibility with PCS 7 V9.1:
• Microsoft Office Professional 2019 32-Bit (Excel, Word, Access and PowerPoint)
On client computers (OS, BATCH, Maintenance, WEB), the Microsoft Office applications Word, 
Excel and Access can be used in process mode. This is also the case when the SIMATIC 
Management Console is operated on these computers. However, their use can result in 
significantly reduced performance in some situations. Microsoft Office must not be used in 
process mode on any other operator stations and BATCH stations.
You can find additional information on the compatibility of SIMATIC PCS 7 under entry ID 
64847781 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

3.4.13 Ethernet settings
Make sure there are no inconsistencies in Ethernet CPs, switches and network adapters in terms 
of their settings/properties for data transmission rate and bus access procedure.
We recommend using the default Autonegotiation setting (procedure for the automatic 
negotiation of the best transmission mode between two network interfaces which are directly 
connected to one another).
You can find information in the section "How to change the transmission rate and operating 
mode in the PC network" of the document "PCS 7 - PCS 7 PC Configuration.pdf" on the SIMATIC 
PCS 7 USB flash drive in the folder "_Manuals\English".
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3.4.14 Remote service and remote operation
Use of the Remote Desktop Protocol (RDP) is permitted only for remote maintenance of PCS 7 OS 
clients. The RealVNC software should be used for remote access to other computers in a 
distributed PCS 7 plant (for example, OS servers, engineering stations). Only one remote session 
is allowed per PCS 7 station at any given time.

RDP
Note the following constraints when using RDP:
• No server services (for example, WebNavigator server, DataMonitor server, OPC server) are 

permitted to be active on the PCS 7 OS clients. The reason for this lies in the handling of 
remote desktop sessions by the Microsoft operating system.

• The existing Windows session must be accepted using the account of the Windows user 
logged on locally.

• The remote station cannot be in the Windows logon screen.

VNC
The "RealVNC" Enterprise Edition software has been tested in PCS 7 V9.1 for compatibility for 
remote service access.
You can find the RealVNC edition suitable for your PCS 7 version in the regularly updated entry 
ID 64847781 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

CAUTION
Access to the operating system level of the local PCS 7 Operator Station (OS) with remote 
access
During remote access to an OS via RealVNC, the remote operator has the possibility of accessing 
the operating system level of the local OS. The local operator of the OS thus also has the 
opportunity - for example via Windows Explorer opened by the remote operator - to access the 
operating system level of the local OS at the same time as the remote operator.

You can find more information about the use of "RealVNC" in PCS 7 plants in the Industry Online 
Support under entry ID 55422236:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/55422236) 

SIMATIC Management Console 
Remote access to the SIMATIC Management Console is generally not approved.
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3.4.15 Remote access to OS projects
All users must have been assigned to the "SIMATIC HMI" user group. This also applies to users 
who want to open the OS projects remotely. Check in particular the following users:
• Users who want to connect a Connectivity Pack Client to a Connectivity Pack Server:

These users must be registered members of the "SIMATIC HMI" group on the Connectivity 
Pack Server.

• Users accessing the Web center of DataMonitor:
1) If you set up a connection to the OS database, you require an additional Windows user and 
password. Assign this user the necessary authorizations for access to the OS database. For 
this purpose, set up a separate Windows user on the server and assign this user to the 
"SIMATIC HMI Viewer" Windows group.
2) To enable access to a remote computer from the DataMonitor server, the Windows user 
and the same password must have been set up on the DataMonitor server and relevant 
remote servers. Register this user and the password in the connection administration of the 
Web center. For this purpose, proceed as specified under point 1.

• Users who want to connect an OPC client with an OpenPCS 7 server:
These users must be registered members of the "SIMATIC HMI" group on the OpenPCS 7 
server.

3.4.16 Information about changing faceplate style variants from Classic style to APL 
style for SIMATIC BATCH or Route Control faceplates

You can only install one of the two style variants (Classic style or APL style) at a time, and change 
the style again by running PCS 7 Setup -> Install -> User-defined installation.
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3.5 Licensing

3.5.1 PCS 7 licenses and quantity structures
An overview of the PCS 7 licensing concept and the quantity structures associated with licensing 
is available in the document "SIMATIC Process Control System PCS 7; Licenses and configuration 
limits".
This document is located on the website for SIMATIC PCS 7 Technical Documentation:
• Internet link (https://siemens.com/pcs7-documentation)

3.5.2 Managing AS runtime licenses
In order for the licenses to be available in sufficient quantities following the activation of the 
license check, we recommend keeping these licenses on the engineering station from where the 
controller usually loads them.

Note
Installation of the AS RT PO licenses
Select the appropriate AS RT PO license installation for your engineering environment:
1. AS RT PO license installed on the local engineering PC

Install the AS RT PO license(s) in sufficient numbers on the engineering PC. The favorites list 
in the Automation License Manager (see menu "File > Settings") must not contain entries or 
the PCs listed do not have AS RT PO licenses.

2. AS RT PO license installed on a license server
Install the AS RT PO license(s) in sufficient number  on the license server PC. The favorites list 
in the Automation License Manager (see menu "File > Settings") must contain the name of 
the license server PC. The local engineering PC must not have an AS RT PO license.
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3.6 Compatibility information

Performing compatibility tests for PCS 7 with various applications
PCS 7 V9.1 has been tested successfully for compatibility with the following applications at the 
time of its release:

Application PCS 7 V9.1
S7 F Systems V6.3 and V6.2 Upd1
Safety Matrix V6.3 Upd2 and V6.2 SP2 Upd2
PLCSim V5.4 SP8 Upd1
WinCC C&A V16 Upd4
Sinema Server V14 SP2
SIMIT V10.2 Upd1
VMware ESXi version 6.7 Hardware versions 11 and 13
Microsoft Defender With a built in version of the operating system
McAfee Application Control V8.3.2
Microsoft SQL Management Studio V18.8
Adobe Acrobat Reader DC -
Microsoft Office Professional 2019 32-bit
SINEC NMS V1.0 SP2

Note
To check the compatibility of your PCS 7 installation with various applications, please use the 
compatibility tool. The latest possible limitations as well as additional compatibility tests that 
were conducted after the release are constantly published there.
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

BANY Compatibility to PCS 7
BanyScope V2.0 is compatible with PCS 7 engineering station, operator station, clients and 
maintenance station. The PROFINET network analysis is also possible via ServiceBridge (the 
BANY CTRL port connected via ServiceBridge to the host system with BanyScope).
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Notes on usage 4
4.1 Automation system (AS)

4.1.1 Switching times for H CPU in connection with a fail-safe application
If you load F-modules, you must select the monitoring time of each F-module as longer than the 
switching time of the active channel in the H system. Notes on the high limit of this changeover 
time can be found in the manual "S7 F/FH Systems - Configuring and Programming," in Section 
"A.7".

Run, F-monitoring, and response times: 
A table with formulas for calculating the high limit is available under entry ID 22557362 in the 
Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/22557362) 
If you do not follow this instruction, F-modules can malfunction when the active channel is 
switched.
You can find additional information in the Safety Engineering in SIMATIC S7 system manual 
under entry ID 12490443:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/12490443) 

4.1.2 ET 200SP

Module AI ENERGY METER ST
You must interconnect and evaluate the data from the process image manually when using the 
AI ENERGY METER ST V1.0. Observe the information about reading out measured values under 
entry ID 81714201 in Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/81714201)
We recommend using and configuring the AI ENERGY METER ST V2.0 module, because the 
channel block FbEnMe is available for this module in the PCS 7 Advanced Process Library. You can 
upgrade an existing AI ENERGY METER ST V1.0 module to the firmware version V2.0. You can 
find the firmware update under the entry ID 98709668 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/98709668)
Read the notes in the manual "PCS 7 Released Modules (V9.1)".

Value status
The "Value status" functionality for ET 200SP modules is not supported.
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4.1.3 ET 200pro
The use of ET 200pro with CP 443-5 Extended is only approved with the 6GK7 443-5DX04-0XE0 
module, firmware version V6.4 or later.
The modules from the ET 200pro series must be configured in DPV1 mode in HW Config. In DPV0 
mode, no interrupts are sent to the PCS 7 diagnostic blocks.

4.1.4 Using S7 PLCSIM
Simple application tests can be carried out with PLCSIM without the availability of AS hardware. 
The required adjustments in the PCS 7 project are described in the "How to test with S7-PLCSIM" 
section of the "Process Control System PCS 7 Engineering System (V9.1)" manual. 
In addition, you must set the "Send/receive raw data block" option to "No" in the connection 
settings for AS-OS compilation.

Note
After using PLCSIM, it might be necessary to re-establish the real connection and recompile the 
changes made to relevant AS including the real connection to the OS.
OS connections with a simulated WinAC Controller (WinLC RTX or WinAC Slot) are not possible. 
See the notes on simulation of a WinAC Controller in the PLCSIM Readme.

4.1.5 Changing the address range of HART modules in ET 200iSP / ET 200M / 
ET 200SP leads to address displacements

If HART auxiliary variables are configured retrospectively for HART modules, this leads to an 
enlargement of the address field required for these modules. The I/O field might therefore be 
redefined. In doing this, the ability to make configuration changes in RUN is lost. Note that your 
project might need to be adapted (symbol tables, CFC charts). 
We recommend configuring the modules with a "CiR" address placeholder in the address range 
of the HART auxiliary variables during configuration. This ensures that the max. address range 
is used and avoids address displacement.

4.1.6 Fast Mode functionality for HART devices 
The HART Fast Mode functionality is supported as of configured module version 6ES7 33?-?
TF01-0AB0 V3.x.
Update 6ES7 33?-?TF01-0AB0 firmware to V3.x
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Download firmware:
• 331-7TF01-0AB0: 

Entry ID 33273268 (https://support.industry.siemens.com/cs/ww/en/view/33273268)
• 332-8TF01-0AB0: 

Entry ID 32011516 (https://support.industry.siemens.com/cs/ww/en/view/32011516)
Replace modules 6ES7 33?-?TF00-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x
• To activate HART-Fast-Mode, you will have to replace the HART module in HW Config (6ES7 

33?-?TF00-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x).
• Then delete the HART field devices and renew the configuration.
• Then activate "HART-Fast-Mode" in the module configuration and "HART RIO SHC Mode" in 

the PDM settings.
Replace modules 6ES7 33?-?TF01-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x
• To activate HART-Fast-Mode, you will have to replace the HART module in HW Config (6ES7 

33?-?TF01-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x).
• Then activate "HART-Fast-Mode" in the module configuration and "HART RIO SHC Mode" in 

the PDM settings.
Redundant modules
HART-Fast-Mode is not possible for redundantly configured modules.

4.1.7 Configuration in RUN (CiR) with FM 350-1, FM 350-2, FM 355, FM 355-2, CP 341
The modules FM 350-1, FM 350-2, FM355, FM 355-2 and CP 341 are CiR-compatible, which 
means that a configuration in RUN can be used so that they can be plugged or pulled via (hot-
swapped) when the AS is in RUN.
Note the following about these modules when configuring in operating mode RUN:
• FM 350-1 and FM 350-2, CP 341:

Changing the module parameters when the CPU is in operating mode RUN resets the module 
and is equivalent to restarting the module.

• FM 355 and FM 355-2:
Bumpless channel-specific changes to module parameters when the CPU is in operating 
mode RUN are possible to a limited extent; refer to the documentation of the FM modules.

4.1.8 Isochronous mode in PCS 7
PCS 7 does not support isochronous mode.

4.1.9 Fault-tolerant connections via internal ETHERNET/PROFINET interface
The S7-400 H as of firmware V6.0 supports fault-tolerant connections via your internal 
ETHERNET/PROFINET interface. 
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If you would like to use fault-tolerant AS-AS connections via the internal interface of the V6.0 H-
CPU, you need to be aware that the connections to the communication partner can only be 
configured via the internal interface of the V6.0 H-CPU or CP 443-1 EX30.

4.1.10 Using PROFINET

Shared Device
The use of PROFINET Shared Device with PCS 7 V9.1 is not supported.

Assigning device numbers
Only device numbers up to 255 are supported by the driver generator in the PROFINET IO system.

CiR functionality 
If you would like to use the  CiR functionality on the PROFIBUS master system for S7-400 PN/DP 
CPU with firmware <= V6.0.2 (article number 6ES7 414-3EM06-0AB0 and article number 
6ES7 416-3ES06-0AB0), you cannot configure PROFIBUS and PROFINET I/O simultaneously for 
the internal interfaces.

Firmware to be used with IM 153-4 PN IO
If you are using the PROFINET module IM 153-4 PN IO (article number 6ES7 153-4BA00-0AB0), 
you need to use a firmware version >= V4.0.1.
You can find information about updating the operating system and downloading the latest 
firmware versions in Industry Online Support under entry ID 26331274:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/26331274)

4.1.11 Using HART auxiliary variables with 4 F-AI HART modules
The configured HART auxiliary variables of the following module are not supported by the PCS 
7 channel blocks:
• 4 F-AI HART (article number 6ES7 138-7FA00-0AB0)
You can obtain additional information in the operating instructions "ET 200iSP Distributed I/O 
Device - Fail-safe Modules" under entry ID 47357221 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/47357221)
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4.1.12 Using PROFIBUS field devices with IE/PB Link
When using SIMATIC PCS 7 AS-RTX you must observe the following:
• Parameter assignment of PROFIBUS field devices which are connected to an IE/PB Link is not 

possible via Industrial Ethernet connections from the PCS 7 Engineering Station (ES). 
• To assign PROFIBUS field device parameters with SIMATIC PDM, connect the ES directly to 

PROFINET of the IE/PB Link.

4.1.13 Compact Field Unit (CFU)
Note that you must not make any changes in HWConfig to the PA slots (FB0- FB7) for a CFU 
station opened in PDM.

4.1.14 Taking advantage of the increased I/O scaling when using CPU 410 SMART.
As of firmware version 8.2.1, CPU 410 SMART I/O scaling for each interface has been increased 
from 1.5 KB to 3 KB. To use the increased scaling, the following requirements must be fulfilled:
1. Object exchange in HW Config to V8.2.1.
2. Use/upgrade to FW V8.2.1 for CPU 410 SMART 
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109476571)
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4.2 Engineering system (ES)

4.2.1 Notes on DocPro
As of PCS 7 V9.1 DocPro is no longer part of PCS 7.
If the user still needs DocPro, it can be downloaded from the Internet (https://
support.industry.siemens.com/cs/us/en/view/109780528). 
If DocPro is not needed but DocPro objects are existent in the project, an instruction on how to 
remove them in order to avoid error messages is provided when the user opens the project in 
PCS 7 V9.1 environment.

4.2.2 Client engineering
Opening clients on the ES can sometimes take a very long time, since it involves an implicit 
update of all server data (packages) that are not up-to-date. Operator input to the SIMATIC 
Manager is not possible during this time.

4.2.3 Notes on Configuration in RUN
Changes can be made to the distributed I/O of an S7-400 AS configuration during ongoing 
operation; these are described in the following documents:

Method System configuration Documentation
CiR 
Configuration in Run

Standard automation system 
(e.g. AS 410S)

Configuration manual for PCS 7 Engi‐
neering System; Modifying the System 
during Operation via CiR 

H-CiR 
Configuration in Run

Fault-tolerant automation system 
(e.g. AS 410H)

Fault-tolerant Systems
S7-400H, chapter 17
• Internet link (https://

support.industry.siemens.com/cs/w
w/en/view/60458386)

4.2.4 CFC/SFC: Download of the automation system (AS)
Programs created with CFC/SFC can only be downloaded with the following functions:
• In CFC/SFC with menu command "PLC > Download"
• In SIMATIC Manager (component view), select the project or station and then the menu 

command "PLC > Compile and Download Objects"
• In the SIMATIC Manager (component view), select charts and then the menu command "PLC 

> Download".
• in SIMATIC Manager using the menu command "Charts > Selective loading"
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Only the loading function of the CFC/SFC guarantees that the engineering data will be consistent 
with the PLC data. Downloading changes to the CFC/SFC in the RUN mode of the S7 CPU is only 
possible when the download is performed exclusively with these functions.

4.2.5 Special characters for the nomenclature
Only certain characters are allowed in names, depending on the language and components. It 
is not recommended to use national special characters.
Special restrictions:
• A comma "," in tag names (process tags, archive tags etc.) is generally not allowed.
• The project name, picture name, and computer name must not contain multibyte characters 

(e.g. Chinese).

For other naming conventions for projects, refer to:
• "Engineering System Configuration Manual"
• WinCC Online Help, using the search term "Illegal characters"

4.2.6 Notes on exporting SNMP variables

Access-protected PCS 7 projects
For projects with activated FDA access protection, you must open the OS project in SIMATIC 
Manager before exporting the OPC configuration.
You can find additional information about exporting SNMP variables, for example, for the PCS 7 
maintenance station, in the function manual "PCS 7 Maintenance
Station".

Notes on usage
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4.2.7 Compiling and downloading S7 connections – downloading to an AS
If connections are to be downloaded to an AS via "PLC > Compile and Download Objects", the 
connections of all connection partners are compiled and loaded. Connection partners here are 
also all the AS that have a configured connection to the same OS as the AS to be downloaded. 
When downloading the connection data to the respective AS, there is a temporary break in the 
connection between AS and OS or between the AS with AS-AS communication.

Note
Monitoring times for fault-tolerant S7 connections
When using fault-tolerant S7 connections via TCP/IP, keep in mind that sufficient monitoring 
times must be configured. Additional information on this topic is available in your SIMATIC NET 
version under entry ID 15227599 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/15227599)

4.2.8 Download
When a "Download" performed from an ES to an OS, the Windows user logged on to the ES must 
be known on the target station and a member in one of the following groups there: At least 
"User", "SIMATIC HMI" "SIMATIC NET", "SIMATIC BATCH" and required SIMATIC Route Control 
"RC_..." groups. In addition, the user also needs full access rights for the folder into which the 
project should be downloaded. This includes the sharing and security settings.

4.2.9 Notes on cross AS interconnections
• When using cross AS interconnections, the S7 program names in the multiproject must be 

different.
• Hardware requirements:

– S7-400 CPU with firmware version >= V3.1
– Communications processor >= 443-1EX10 V2.1.
– PCS 7 AS RTX 

• If there is an overload on the S7-400 CPU or if there are network disruptions, the following 
messages can appear: "Overload sender: S7 connection ID xxxx". This means that a data 
transfer cycle could not be executed. The data will be transferred in the next cycle.
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4.2.10 F-monitoring time of F-modules and F-field devices downstream from a Y-Link/
DP-PA Link 

By extending the calculation of the monitoring times for updating the reserve, it is possible as 
of PCS 7 V7.1 SP1 to consider F-monitoring times of F-modules and F-field devices downstream 
from a Y-Link/DP-PA Link.

Note
When you activate the option "Calculate F-modules after Y-Link" you will change the CRC for the 
F-module configuration. You will have to compile the F-program once again.
You might have to adjust the F-monitoring times of the affected F-modules and F-field devices 
prior to the calculation.
Use the Excel file "s7ftime" to determine the F-monitoring times for F-modules after Y-Link and 
F-field devices on PROFIBUS PA.
SIMATIC S7 F Systems: execution times of fail-safe blocks, runtime of F-shutdown group, 
monitoring and reaction times. 
Entry ID 22557362: 
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/22557362)

4.2.11 Configuration of fail-safe modules in ET 200M PROFINET stations
In order to operate fail-safe applications on PROFINET, the following requirements must be met:
• All configured devices and the employed F-drivers must support PROFIsafe V2 mode
• The S7 F Configuration Pack version used must be V5.5 SP13 
Note the following before the first compilation of the hardware configuration:
• For fail-safe operation on PROFINET, be sure to use only fail-safe modules that are listed in the 

"PCS 7 V9.1" module filter under PROFINET IO -> I/O -> ET 200M.
• Be sure to use a version >= V1.3 of the SIMAITC S7 F Systems library in your project. If you 

have not yet used F-blocks in your project, place at least one F-block from the F-library version 
>= V1.3 within a CFC (for example, F-channel drivers).

4.2.12 Merging projects after distributed editing (multiproject engineering)
If you merge projects into a multiproject, you have to execute the following menu command: 
"File > Save as... > With Reorganization (slow)".
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4.2.13 Note on upgrading process objects of a CPU 410-5H system expansion card
During the upgrade of the process objects of a CPU 410-5H system expansion card (SEC), only 
one instance of the Automation License Manager (ALM) can be active.

4.2.14 Notes on AS-OS compilation

Using named connections
Within the context of PCS 7, we recommend using "named connections" for the AS-OS 
connection.
If you are using a connection type other than "named connections", you take note of the "Send/
receive raw data block" option in the connection settings during AS-OS compilation. You should 
set this option to "No" if it is not needed for special applications.

4.2.15 Notes on updating block contacts at SFC types
There is a possibility that changes which have not been applied yet, which means updates of 
block contacts at SFC types, are present in existing projects. Therefore, check your project (if you 
are using SFC types with block contacts) to see if any such changes have been made.
To do this, select the menu command "Options > Block contacts" in the SFC Editor while the SFC 
type is open.
If there are still block contacts that still have to be updated, select them and click "Update".

Note
After these updates, the respective SFC instances must be stopped for downloading.

Refer to the entry ID 109751583 in the Industry Online Support for instructions on how to 
handle updates of block contacts at SFC types that have not been adopted: 
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109751583)

4.2.16 Configuration of fault-tolerant S7 connections with max. redundancy (with 4 
connection paths)

Configuration of fault-tolerant S7 connections with max. redundancy (with 4 connection paths) 
is possible if the recommended connection schema of the interfaces to the plant bus is used.
The recommended connection schema is:
Rack0: CP1 or CPU 410-5H.X5 -> Plant bus 1
Rack0: CP2 or CPU 410-5H.X8 -> Plant bus 2
Rack1: CP1 or CPU 410-5H.X5 -> Plant bus 2

Notes on usage
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Rack1: CP2 or CPU 410-5H.X8 -> Plant bus 1

4.2.17 How to handle CiR in PCS 7
Handling CiR in PCS 7 is explained in detail  in the Process Control System PCS 7: Engineering 
System V9.1 configuration manual.

4.2.18 TCiR in PCS 7 environment
TCiR in PCS 7 environment is supported only with a CPU firmware version V8.2 (or higher). 

4.2.19 Export entire plant configuration
The customer must perform the complete export once for existing devices of type switch in 
order to correct the variables that are created already.
The user needs to execute the step: "HW Config > OPC Server > SNMP > Tag Export > Export entire 
plant configuration"

Notes on usage
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4.3 PCS 7 libraries

4.3.1 Upgrading the project
When upgrading your project, be sure to consider the compatibility of the PCS 7 libraries 
according to "Compatibility Tool for Automation and Drive Technology". For more information, 
refer Internet (https://support.industry.siemens.com/cs/ww/en/view/64847781).
Also, follow the steps mentioned in the  Software update without utilization of new functions 
upgrade manual. For more information, refer Internet (https://
support.industry.siemens.com/cs/ww/en/view/109767558) and select appropriate date from 
the drop-down list.

4.3.2 Diagnostic alarms for digital input modules SM 321-7BH00 and SM 321-7BH01

Diagnostic evaluation for channel-based diagnostic interrupts of the module 
When using digital input modules SM 321-7BH00 and SM 321-7BH01, the diagnostic evaluation 
for a channel-based diagnostic interrupt is performed in channel groups. 
When using digital input module SM 321-7BH01 HF, the channel-related diagnostic interrupt 
takes place for each individual channel.

Diagnostic option: Missing encoder supply 
SM 321-7BH00 and SM 321-7BH01
• Digital input channels 0 to 7 are combined into channel group 0.
• Digital input channels 8 to 15 are combined into channel group 1.
Eight alarms are output for each channel group if the encoder supply is missing. 
• "Error channel 00" to "Error channel 07" or
• "Error channel 08" to "Error channel 15"

Diagnostic option: Wire break
For SM 321-7BH01 only 
• Digital input channels 0 and 1 are combined into channel group 0
• Digital input channels 2 and 3 are combined into channel group 1
• Digital input channels 12 and 13 are combined into channel group 6
• Digital input channels 14 and 15 are combined into channel group 7
The channel involved can therefore not be clearly identified in the text of the diagnostic interrupt/
diagnostic message.
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4.3.3 Faceplate Designer

Creation and modification of user-specific faceplates
The creation and modification of user-specific faceplates using the "Faceplate Designer" is no 
longer supported as of version V9.0.

4.3.4 Using Basis Library V9.0.3 with PCS 7 V9.1
To use Basis Library V9.0.3 with PCS 7 V9.1, the version of the Basis Library should be greater 
than or equal to V9.0.3.1.

4.3.5 IE/PB Link HA as S2-Devices on H-System
When IE/PB Link HA is connected with the intelligent DP slaves in a H-system, use PCS 7 Basis 
Library as of V9.1 Update 1. 
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4.4 Operator station (OS)

4.4.1 OS-specific information and notes on installation and use
You will find PCS 7 OS-specific information and notes on installation and use of this component 
in the readme file of the product.

4.4.2 Customized user programs
If you create your own applications, system tests in the relevant environment are necessary to 
ensure the stability of the entire system.

4.4.3 Starting process mode on the OS server
• Process mode will not be started on an OS server if this server is not connected to the network.
• When you start process mode on a redundant server, make sure that the first server takes over 

process mode completely before the redundant partner is started. No client should be active 
before process mode is started on a server for the first time. The OS clients can then be 
activated.

4.4.4 Deactivating a redundant OS server
Before deactivating a redundant server, ensure that the partner server is in a state that is fault-
free and operational (for example, there are no process coupling faults). Archive 
synchronization must be completed before deactivation, which can be recognized with the 
corresponding process control message.

4.4.5 OS change download

Procedure for extensive changes
If an AS has been added, a redundancy switchover and entries in the message system can occur 
when changes are download. The following procedure is recommended when extensive 
changes are involved: Configure the changes in single steps ("packet-by-packet") on the ES and 
then transfer them to the OS in individual "packets".

Notes on usage
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Changes to tags with access to an OPC-DA-Client application
It might happen during configuration that tags are deleted from a project that are requested at 
this time by an OPC-DA-Client application using a Subscription. Restoration of these tags in the 
project will not automatically initiate an update of the tags by means of OPC. Provided the tags 
in question are available in an OS server project and the OPC DA server is running on an OS client 
or OpenPCS 7 station, it is sufficient to initiate a redundancy switchover of the corresponding OS 
server project to trigger an update of the tags. Otherwise, the OPC-DA-Client application needs 
to re-register the tags in question.

4.4.6 Setting access permissions in the operating system
A PCS 7 OS automatically sets the "SIMATIC HMI" local user group following installation under 
Windows. The currently logged on user and local administrator are registered in this user group. 
Enter the users who should have access to PCS 7 OS in the  "SIMATIC HMI" group with their logon 
information.
You can find more detailed information in:
• The WinCC Information System under "Installation Notes > Installation Requirements > 

Access Permissions in the Operating System"
• The document "PCS 7 - PC Configuration.pdf” on the SIMATIC PCS 7 USB flash drive  in the 

folder "_Manuals\English"
• The PCS 7 Compendium Part F - Industrial Security. 

Internet link (https://support.industry.siemens.com/cs/ww/en/view/109782722)
All Window users who work with PCS 7-, PCS 7 OS or Route Control projects must also be 
members of the "SIMATIC NET" group.

4.4.7 Controls
Using controls from third-party suppliers can lead to errors such as performance problems or 
system blockage. The user of the software must assume responsibility if problems are caused by 
third-party controls. We highly recommend that you run a system test to ensure safe operation 
before putting them into use.

4.4.8 User interface and design
In PCS 7, make the following setting for the appearance of the user interface in process mode:
• Design "WinCC 3D"
All other WinCC designs are not supported by PCS 7.
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Note the following:
• Make sure that the design is set in a uniform manner for all the projects of a plant.
• If you change the setting of the design, check the visualization of self-generated objects and 

adapt these if necessary.
• Retain the setting if you update the software. During a software update, changing the setting 

for the appearance of the user interface in process mode could cause considerable changes.

4.4.9 Disabling / enabling messages using the WinCC Alarmcontrol
The disabling / enabling messages functionality using WinCC Alarmcontrol has not been 
approved for PCS 7.

4.4.10 Language setting for C scripts

Note
WinCC now supports Unicode.

To ensure your C scripts run without problems, you need to make sure that the language set in 
the Global Script C editor is correct. 
If you select "Dynamic: Project setting", scripts run in the language that was set globally for the 
project. 
You can make this global project setting under "C scripts with language setting "Dynamic" in 
Runtime" in the "Options" tab, which is located in the "Project properties" dialog box of the WinCC 
Explorer. 
The "Operating system language for non-Unicode programs" option is preset and recommended 
as the global project setting for PCS 7. You can find additional information in the WinCC 
documentation (WinCC Information System) and the WinCC readme.

4.4.11 Consistency between the plant hierarchy and the Picture Tree Manager for 
SFC visualization

To prevent delays during the start of OS Runtime and during SFC operation on the OS client, you 
need to ensure the following:
• all areas of the plant hierarchy (PH) that contain SFC charts must also be created by name in 

the WinCC Picture Tree Manager.
OS areas which should not be available for selection in WinCC Runtime can be configured as 
invisible via the OS project editor.
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4.4.12 Prevent operating system access through key combinations
With the option "Disable shortcut keys for operating system access" in the properties of the PCS 7 
OS computer, the key combinations for ease of access are also disabled.

4.4.13 Setting the Windows taskbar for multi-monitor cards
In multi-monitor mode, the same zoom level must be configured for all monitors in the operating 
system. The Windows taskbar can only be displayed on the primary monitor and cannot be 
extended to other monitors.

4.4.14 WinCC Service mode
The WinCC service mode is released in connection with PCS 7 OS for the following 
configurations:
• PCS 7 OS Server 
• PCS 7 Maintenance Station
• PCS 7 OS Server combined with PCS 7 Maintenance Station

4.4.15 PCS 7 Process Tag Browser
In the PCS 7 Process Tag Browser, only such process tags are listed which are assigned to the 
image hierarchy of the OS project.
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4.5 SIMATIC BATCH

4.5.1 Compiling and loading BATCH with the "Compile and Download Objects" 
function

Note that when you modify projects, compiling and loading should always be performed in the 
following sequence: AS, OS, BATCH.

4.5.2 Access permissions
The following sharing is set for SIMATIC BATCH during the installation:
• BATCH
The PCS 7 software manages the share permissions automatically. 
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4.6 SIMATIC Route Control

4.6.1 Loading the SIMATIC Route Control server in conjunction with SIMATIC NET 
Softnet IE-RNA

If the "Unknown" status continues to be displayed after loading the SIMATIC Route Control server 
from the ES of the SIMATIC RC SERVERDIALOG, you need to do the following: 
• Open the Microsoft Management Console for services using Start > Run: Enter "services.msc"
• Change the start type from "Automatic" to "Automatic (delayed start)" for the following 

services:
– SCSMonitor
– SIMATIC Route Control Server

• Reboot the computer.

4.6.2 Autostart of SIMATIC Route Control and WinCC
When autostart of SIMATIC Route Control and WinCC is configured and autologin of 
Windows Server 2019 is enabled, it is necessary to set the following services to "automatic with 
delay":
• Open the Microsoft Management Console for services using Start > Run: Enter "services.msc"
• Change the start type from "Automatic" to "Automatic (delayed start)" for the following 

services:
– SCSMonitor
– SIMATIC Route Control Server

• Reboot the computer

4.6.3 Configuration limits - Increasing the maximum number of Route Control 
Elements (RCE)

The permissible value range of the Route Control Elements is documented in the "Programming 
and Operating Manual" of the SIMATIC Route Control product in the chapter "Configuration 
limits".
The maximum number of Route Control Elements (RCE) over all sub-paths of the entire Route 
Control project is now 100,000* (instead of 64,000).

Note
*This involves theoretical limits which can be further restricted by other system properties.
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4.7 SIMATIC PDM

4.7.1 Using the Device Integration Manager
Once you have installed SIMATIC PDM, you must import the devices you are using onto your 
computer. Run the "Device Integration Manager" program for this. 
The devices supported by PDM are included on the supplied "Device Library". You can download 
the latest version from the Support area of the SIMATIC PDM website.
• Internet link (https://support.industry.siemens.com/cs/ww/en/ps/16983/dl)

4.7.2 Canceling the module redundancy for HART modules of ET 200M remote IOs
In order to cancel the module redundancy set in the hardware configuration (HWC), you need to 
adhere to the following procedure:
1. Delete the module in question and then compile the hardware project
2. Remove the deleted module from the process device plant view or network view
3. Configure the module again in HWC
This ensures that the redundancy is removed correctly.

4.7.3 Note on project migration
When migrating a PDM project from a previous version, it is absolutely necessary to do the 
following: 
• Install all add-on packages used in the project before you open the project for the first time.
• Projects are migrated automatically when you first open them.
You can find additional important information in the SIMATIC PDM readme in the section 
"Migrating Projects".
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4.8 Process Historian (PH)

Commissioning the PH
If you want to integrate the PH into your system for the first time, you need to consider the 
following:
The PH only starts to reference data from the OS servers and BATCH servers if it is activated 
before they are. You therefore might need to restart the OS server or BATCH server to adhere to 
this sequence of events. 

Note
PCS 7 V9.1 supports a non redundant PH.
PH migration from PH2014 to PH2020 is not supported. Hence in a plant with PH system, 
migration to PCS 7 V9.1 is not possible
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4.9 Information Server (IS)

Installation of IS 2020
Read the instructions in "InstallNotesINFSVenUS.pdf" for the installation of IS 2020. You will find 
the file on the SIMATIC PCS 7 USB flash drive in the folder "27b_PH+IS_Install_and_Release-
Notes".

Note
IS migration from IS2014 to IS2020 is not supported. Hence in a plant with IS system, migration 
to PCS 7 V9.1 is not possible.

Installation of SIMATIC IS - BATCH Options
The installed version of the IS BATCH Options must match the version of the SIMATIC BATCH 
Server.
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4.10 PCS 7 Web Option

PCS 7 Web server
Information about the PCS 7 Web add-on package is available in the "PCS 7 Web Option for OS" 
manual. This document is located on the website for SIMATIC PCS 7 Technical Documentation:
• Internet link (www.siemens.com/pcs7-documentation)

WinCC/WebUX
As of WinCC/WebUX V7.4, process pictures from PCS 7 projects are also supported. The same 
restrictions as for process pictures from WinCC projects apply.
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4.11 DataMonitor (DM)

Operating and monitoring via the Web
The "Process Screen" function is no longer used for operator control and monitoring via the Web 
in DataMonitor. Instead, the "WinCCViewerRT" Web viewer can be used on the DataMonitor 
client. 
For more information, please see the "DataMonitor Release Notes".

Restrictions on usage of the DataMonitor server
Always use the DataMonitor server on a computer that is not operated in WinCC ServiceMode.
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4.12 OpenPCS 7

Evaluation of "Active Time"
"Active Time" cannot be used for evaluations with Historical Alarm&Event.

Project languages
If you have project languages other than Western European Languages (code page Windows – 
1252), an OPC A&E Client can only use the languages "German" or "English", as offered by the 
OpenPCS 7 OPC server. 

Changes to tags with access to an OPC-DA-Client application 
Observe the section OS change download (Page 54).

Downloading the OpenPCS 7  station
Following installation or update of OpenPCS 7, you need to perform a "Download" of the 
OpenPCS 7 station on the engineering station.
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4.13 Redundant systems
PCS 7 as of V7.1 SP2 contains advanced self-diagnostics for redundant software systems 
(servers). If this diagnostics routine detects an internal fault, if the redundant partner server is 
fully functioning, all communication connections on the server affected by the fault are 
disconnected (terminal and system bus). 

Example:
• WinCC and BATCH Server are running on server (A).
• The full function of the redundant partner server (B) is achieved when WinCC and BATCH 

Server are running on server (B) and the runtime data of WinCC and BATCH are synchronized.
Automatic restart of the affected server is only performed when this full functionality is achieved.

Requirements
• Use of a PCS 7 OS (multi-station) redundant system, SIMATIC BATCH or SIMATIC Route 

Control.
• You must make the following configuration settings on the server systems:

– Automatic Windows logon (not relevant for servers in WinCC service mode)
– Automatic start of the PCS 7 server applications

• Disable the group policy "Display event logging for shutdown"
Procedure:
– Use [Windows button]+[R] to launch the "gpedit.msc" file and open the following path in 

the group policies editor:
Computer Configuration > Administrative Templates > System

– Disable the group policy "Display event logging for shutdown"
• Before a PCS 7 server application is exited, an availability check is carried out on the relevant 

redundant partner server. The aspect of the data synchronization is also taken into account 
in the availability check.
If the partner server is not fully functional, the user is informed of this status and can proceed 
accordingly.
For more information, refer to the section "Setting the permissions for restarting the system" 
under the chapter Requirements (Page 20).

Activation of automatic logon in Microsoft Windows 
You can find a description of the options for activating automatic logon in Microsoft Windows 
under entry ID 23598260 in the Industry Online Support:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/23598260)

Additional information
You can find additional information in the corresponding application descriptions (manual and 
readme for PCS 7 OS, SIMATIC BATCH, SIMATIC Route Control, SIMATIC NET).
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4.14 SIMATIC NET

VLAN architectures for PCS 7
You can find information about configurations with virtual LANs (VLAN) available with PCS 7 in 
the Industry Online Support under entry ID 66807297:
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/66807297)

Using SIMATIC NET Softnet IE-RNA in connection with WinCC secure communication
If you use secure communication between PC stations, we recommend that you use the 
"Automation Firewall" released for PCS 7 as a back firewall for communication across the plant.
You can find additional information in section "Setting package size for communication (MTU 
size)" of the PCS 7 manual "PCS 7 - PCS 7 PC Configuration.pdf".
Internet link (https://support.industry.siemens.com/cs/ww/en/view/109754983)
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4.15 SIMATIC Management Console

Using whitelisting with McAfee Application Control
The following functions of the SIMATIC Management Console are not available using active 
whitelisting with McAfee Application Control:
• Creating setup package
• Starting computer-specific installation

Notes on usage
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4.16 Maintenance Station

Note regarding "Call configuration data" function in the diagnostic screens of the maintenance 
station

A warning notice is displayed when a website is called with the "Call configuration data" icon 
whose HTTPS certificate cannot be checked. 
Result:
The operator can use this warning notice to gain access to the operating system level of the local 
PCS 7 Operator Station (OS) despite enabled keylock.
 Remedy:
• Enter all necessary certificates in the list of trusted certificates in Internet Explorer for all PCS 7 

operator stations which display diagnostic screens of the maintenance station.
Recommendation:
• To increase security, we recommend replacing the default certificates with appropriate 

certificates for all web servers.

Asset ID 
From this version onwards, Asset ID is made available for all asset devices print report. 

SINEC-NMS

Note
If SINEC-NMS is used on a PCS 7 Maintenance Station, minimum of RAM of 16 GB is necessary.

Notes on usage
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4.17 SIMATIC PAM Station 
Note
The stand alone maintenance station for package units and smart field devices is a product of the 
SIMATIC PCS 7 product family and is installed via the media package from SIMATIC PCS 7. 
Information on application and engineering can be found in the "Process Control System PCS 7; 
Maintenance Station" manual and on the Internet  (https://
support.industry.siemens.com/cs/ww/en/view/109767562). Under "Edition" drop down list, 
select the latest one.

The SIMATIC PAM Station V2.0 has been developed, tested and released on the following 
hardware:
SIMATIC IPC 547G, 647E or 847E with OS Windows Server 2019 as SIMATIC PAM operator station
SIMATIC AS-Station 410 V8.2 as SIMATIC PAM signal processing station.
It is recommended to operate the plant with the appropriate secure hardware in order to protect 
communication between the stations in the plant. For example, in this case, use a programming 
device / PC - Industrial Ethernet CP 1628 and S7-400 - Industrial Ethernet CP 443-1 Advanced.
For more information, refer to the notes in the SIMATIC PCS 7 Release Modules V9.1 manual.

Notes on usage
4.17 SIMATIC PAM Station 
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4.18 SIMATIC PDM MS
Note
The stand alone maintenance station for smart field devices is a product of the SIMATIC PCS 7 
product family and is installed via the media package from SIMATIC PCS 7. Information on 
application and engineering can be found in the "Process Control System PCS 7; Maintenance 
Station" manual and on the Internet (https://support.industry.siemens.com/cs/ww/en/view/
109767562). Under "Edition" drop down list, select the latest one.

The SIMATIC PDM MS can be operated on IPC stations that meet the performance data of the 
SIMATIC IPC 427E.
For more information, refer to the notes in the SIMATIC PCS 7 Release Modules V9.1 manual.

Notes on usage
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4.19 SIMATIC IPC DiagMonitor
DiagMonitor V5.1 SP5 has been tested with PCS 7 V9.1 for compatibility.
If a version of DiagMonitor < V5.0 is already installed on the system, take note of the following 
for installation of DiagMonitor V5.1 SP5:
• Reboot the computer once the program has been uninstalled.
Run the following files on the SIMATIC PCS 7 V9.1 USB flash drive under Additional_Products > 
DiagMonitor_V5.1 + SP5 one after the other to perform the installation:
• DiagMonitor_Silent_Install.bat
• CM_Activate.exe
Reboot the computer after executing the CM_Activate.exe.
You can find additional information on the installation and the approved types of computers in 
the document "GettingStarted.pdf" in the installation folder.

Notes on usage
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4.20 SIMATIC Safety Matrix and S7 F Systems

SIMATIC S7 F Systems
SIMATIC S7 F Systems V6.2 Upd1 and  V6.3 have been tested with PCS 7 V9.1 for compatibility. 
You can find additional up-to-date information on SIMATIC S7 F Systems in the Industry Online 
Support at:
• Internet link (https://support.industry.siemens.com/cs/ww/en/ps/14363) 
See section "4.3 Conversion to S7 F Systems V6.3" in the "SIMATIC Industrial Software S7 F/FH 
Systems; Configuring and Programming" manual.
• Internet link (https://support.industry.siemens.com/cs/ww/en/view/109773062)
The S7 F Device Integration Pack is part of SIMATIC S7 F Systems. It provides the fail-safe modules 
of the ET 200SP HA and, in addition to the F-Configuration Pack, fail-safe modules of the ET 
200SP in the hardware configuration of STEP 7. 
Download S7 F Device Integration Pack V6.3 SP1
• Internet link  (https://support.industry.siemens.com/cs/de/en/view/109782016)

SIMATIC Safety Matrix
SIMATIC Safety Matrix V6.2 SP2 Upd2 and V6.3 Upd2 have been tested for compatibility with 
PCS 7 V9.1.
You can find additional up-to-date information on SIMATIC Safety Matrix in the Industry Online 
Support at:
• Internet link (https://support.industry.siemens.com/cs/ww/en/ps/14364)

Note
SIMATIC Safety Matrix faceplates are not compatible with the PCS 7 V9.1 OS Webclient.

Notes on usage
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4.21 Notes on PCS 7 Model Predictive Control (MPC)
As of PCS 7 V9.1, the PCS 7 MPC V8.1 is no longer part of PCS 7.

Notes on usage
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4.22 SIMATIC Logic Matrix
If a cause is used with digital inputs only, the handling of alarms does not work. This is corrected 
with Logic matrix V9.1 Update 1. 
After installing the update, the OS must be compiled with scope of entire OS.

Notes on usage
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4.23 Security

Information Integrity and Authenticity (content.cat)
Prior to the software installation in the plant, the integrity and authenticity of the software must 
be checked.
The integrity and authenticity of software can be safeguarded in various ways:
• Sealed delivery media
• Hash on download page
• Authenticode signatures 
For more information, refer Internet (https://docs.microsoft.com/en-us/windows-hardware/
drivers/install/authenticode)

Note
We recommend that you obtain the software only from trusted sources.

The physical installation media as well as the software on distribution points (for example: 
fileshare) must be protected in order to prevent manipulation, for example, through a virus, see 
SIMATIC PCS 7 Compendium Part F chapter "5.6.3. Quarantine station as data exchange point" 
for more information.
SIMATIC PCS 7 offers multiple possibilities for checking the integrity and authenticity of the 
software:
• The packaging is sealed.
• Software and firmware downloaded from the support page is signed digitally. Before it is run, 

this signature is checked by the operating system. A SHA256 checksum with which the 
integrity can be checked at any time and is also published on the download page.

• The integrity and authenticity of the SIMATIC PCS 7 software is safeguarded with a catalog 
file available on the Internet (https://docs.microsoft.com/en-us/windows-hardware/drivers/
install/catalog-files). This file is supplied on the installation medium and is used to check the 
integrity of the software before the installation via SIMATIC Management Console.
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4.24 Notes on the documentation

PUD Manager links to the Service & Support Portal for Windows Server 2019
For security reasons, links from Plant and User Documentation Manager (PUD Manager) to the 
Service & Support Portal (SIOS) do not work with Windows Server 2019.
For more information, refer to Process Control System PCS 7; PUD V2.1 Online Help under 
Technical documentation (https://www.siemens.com/pcs7-documentation).

PUD Manager
The key points that the user must remember while using the PUD Manager are:
• First Help call needs more time for the initialization of the PUD Manager. The autostart setting 

is active only on ES/single station. The first startup time ranges from 30s to 120s.
• After the initialization, the PUD Manager stays active in the main memory (RAM) in order to 

ensure a quick response to subsequent help calls.
• The used RAM can be emptied by the user when it is required. The PUD Manager needs to be 

shutdown using the option Tray-Icon > Right Mouse > Exit. After the exit, the PUD Manager 
behaves as mentioned in the above two points.

Notes on usage
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Software components in SIMATIC PCS 7 V9.1 5
SIMATIC PCS 7 SW components PCS 7 V9.0 SP3 with UC01 PCS 7 V9.1
Products   
Automation License Manager V6.0 + SP8 V6.0 + SP9 + Upd1
STEP 7 Basis V5.6 + SP2 + HF5 V5.6 + SP2 + HF6
CFC V9.0 + SP5 V9.0 + SP5 + Upd2
S7-SCL V5.6 + Upd 1 V5.6 + HF1
SFC V9.0 + SP5 V9.0 + SP5 + Upd2
TH V9.0 + SP5 V9.0 + SP5 + Upd2
IEA-PO V9.0 + SP5 V9.0 + SP5 + Upd2
PCS 7 Basis Library V9.0 + SP3 + Upd4 V9.1
PCS 7 Advanced Process Library V9.0 + SP3 + Upd4 V9.1
PCS 7 MPC V8.1 n.a.
Logic Matrix Library V9.0 + SP2 + Upd2 V9.1
Logic Matrix Engineering Tool V9.0 + SP2 + Upd2 V9.1
VersionCrossManager V9.0 + SP5 V9.0 + SP5 + Upd1
Version Trail V9.0 + SP5 V9.0 + SP5 + Upd2
PCS 7 PID Tuner V8.0 + SP1 + Upd2 V8.0 + SP1 + Upd2
DocPro V9.0 + SP3 n.a.
S7-PLCSIM V5.4 + SP8 + Upd1 V5.4 + SP8 + Upd1
SIMATIC WinCC V7.4 + SP1 + Upd16 V7.5 + SP2 + Upd1
WebNavigator V7.4 + SP1 + Upd16 V7.5 + SP2 + Upd1
DataMonitor V7.4 + SP1 + Upd16 V7.5 + SP2 + Upd1
Process Historian Version 2014 SP2 + Upd5 Version 2020
Information Server Version 2014 SP2 + Upd5 Version 2020
Process Historian TrendViewer n.a. Version 2020
OpenPCS 7 V9.0 + Upd3 V9.1
SFC Visualization V9.0 + SP5 V9.0 + SP5 + Upd2
AS-OS-Engineering V9.0 + SP5 V9.0 + SP5 + Upd2
PV InsInfo Server V9.0 + SP5 V9.0 + SP5
XML TRANSFER n.a V9.0 + SP5 + Upd2
PCS 7 Basis Faceplates V9.0 + SP3 V9.1
PCS 7 Advanced Faceplates V9.0 + SP3 + Upd3 V9.1
Logic Matrix Faceplates V9.0 + SP2 + Upd2 V9.1
SIMATIC NET PC-Software V14 + SP1 + Upd13 V16 + Upd4
SIMATIC NET PC Software Doc V14 + SP1 V16
SIMATIC NET SOFTNET-IE RNA V14 V16 + SP1
SIMATIC Management Console V9.0 + SP1 + Upd2 V9.1
SIMATIC Management Agent V9.0 + SP1 + Upd2 V9.1
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SIMATIC PCS 7 SW components PCS 7 V9.0 SP3 with UC01 PCS 7 V9.1
SIMATIC PUD Manager V2.0 + Upd2 V2.1
SIMATIC BATCH V9.0 + SP1 + Upd6 V9.1
SIMATIC Logon V1.6 + Upd2 V1.6 + Upd3
SIMATIC PDM V9.1 + Upd7 V9.2
SIMATIC PDM Devices Internet download (https://support.industry.siemens.com/cs/ww/en/ps/16983/dl)
SIMATIC Route Control V9.0 + Upd4 V9.1
PCS 7 System Documentation Internet link (https://support.industry.siemens.com/cs/ww/en/view/109744320)
PCS 7 Tools V9.0 + SP3 + Upd1 V9.1
SQL Server 2014 SP3 2017
   
Additional_Products:
(manual installation required)

  

Crystal Reports for Route Control V11.0 V11.0
DiagMonitor V5.1 + SP3 V5.1 + SP5
Information Server BATCH Options V8.0 + SP1 + Upd22

V8.1 + SP1 + Upd17
V8.2 + Upd10

V8.0 + SP1 + Upd22 
V8.1 + SP1 + Upd17 
V8.2 + Upd10
V9.0
V9.0 + SP1 + Upd6

HCF_HART-Server V3.2 n.a.
Report Builder V3.0 n.a.
MTU V1.0 V1.0
S7 Block Privacy V1.0 + SP4 V1.0 + SP4
SIMATIC Assessment Suite - Data Collec‐
tor

SAS-DC_2019_1 SAS-DC_2020_2

SIMATIC Management Agent V9.0 + SP1 + Upd2 V9.1
SIMATIC Management Console
InventoryDataProfile

V9.0 + SP3 V9.1

SIMIT VC for PDM MS n.a. V4.0
PAM_Templates n.a. Versionless 
   
Other:   
PKZIP V14.4 V14.4
DotNetFramework V4.6.2 V4.8
   
S7 F Systems V6.21 V6.31

SIMATIC Safety Matrix V6.2 + SP2 + Upd21 V6.3 + Upd21

SIMATIC S7F Device Integration Pack  V6.3 + SP1: Download: (https://
support.industry.siemens.com/cs/de/en/
view/109782016)

1 Delivery on separate data storage medium

Software components in SIMATIC PCS 7 V9.1
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